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What's New in montage.factory 1.0.02 (23/12/2023)
Provided a workaround for the OSX Java file selector bug that reports a non existent directory when
you have double clicked a directory to select it.

• 

Improved registration process. You now no longer have to quit the program to activate the disabled
features once registered and activated.

• 

Application rebuild to stay current with latest version of Java 17, required libraries and build tools.• 

Previous Versions
V1.0.01 (10/09/2023)

Added a new feature that disables any edits to a file when a file is as read only. Drag copy, and
clipboard copy and Save As are still enabled.

• 

Added a new feature that when enabled in Preferences creates JSON files when a file is opened or
saved.

• 

Fixed a problem with files and live set references when migrating older version files to the latest file
version.

• 

Fixed a problem with JSON file creation when the Montage performance name has invalid characters
at the start.

• 

Fixed a problem which was stopping files from opening when there is no library header in the file.• 

V1.0.00 (20/12/2022)

First Public Release• 

V0.1.00 (05/06/2022)

First Beta Release• 

V0.0.00 (2020-2022)

Alpha Development• 

 What's New in montage.factory 1.0.02 (23/12/2023) 1



Installation and Configuration of montage.factory
montage.factory is downloaded as a self installing file for OS X, Windows and Linux, so installation is
automatic, and for most users little else, if anything, needs to be done to get up and running.

Simply download the installer from the x.factory Products Page for your platform (PC, OS X or Linux) and run
the installer, following the installer prompts.

ZIP and TAR files are also provided if you are having difficulties running the supplied installers, which should
get you running on any platform capable of running Java 17

Further installation guidance is given on the x.factory Installation Page page.
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Registering montage.factory
You need to register montage.factory to allow data to be saved to your computer and for Library Support to be
enabled.

Please refer to the x.factory Librarian Registration Page for details on how to register montage.factory.
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Running montage.factory
Starting up montage.factory is as simple as starting any application, simple double click on the icon and you're
away.

If you have registered montage.factory, then the Library will be created (if it doesn't already exist) and opened.

During start-up, a "Splash Screen" is shown. This stays visible until a few seconds after the program has
loaded and is ready for use, but can be dismissed at any time by clicking on the Splash Screen.

montage.factory remembers the size and position of the main window between sessions, so the main window
will be sized and positioned as you left it the last time.

PC
Simply double click on the program icon for the program either in an Explorer shell, or from the desktop if you
let the installer placed a shortcut there.

You can also select the program from the Start Menu. By default, montage.factory can be found under the
x.factory Librarians Program Group.

MAC OS X
Navigate to the Applications folder in Finder and double click the montage.factory application.

You can also create "Aliases" of the application and place them anywhere you wish, such as on the desktop

To make an alias you can choose any one of the following methods:

Click the montage.factory item you have just identified and hold down the mouse button. Then, while
holding down the Command and Option keys simultaneously, drag the item to where you want the
alias to appear then let go of the mouse button and finally release the two keys. This will create an
alias at your desired location. While dragging, the ‘ghosted’ item will display a shortcut arrow which will
remain on the aliased icon when it has been created.

• 

Hold down the Ctrl key, and then click the montage.factory item as identified previously. The context
menu will be displayed, and one of the choices will be Make Alias. Click that option, and then release
the key. The montage.factory alias will appear next to the original item and can be dragged to your
location of choice.

• 

Select the montage.factory item you identified previously by clicking it once then press Command-l
(lowercase L). The montage.factory alias will appear next to the original item and can be dragged to
your location of choice.

• 

Click the montage.factory item once to select it, and then from the File menu, select Make Alias. The
montage.factory alias will appear next to the original item and can be dragged to your location of
choice.

• 

Note that if your alias does not have a small arrow in the lower left corner then you have not correctly created
an alias and have probably just dragged the application launcher to a new location. If so, drag it back to the
Application folder and start again.

Command Line
You can also startup montage.factory from a command shell (e.g. CMD on PC or Terminal on OS X). Simply
change directory to where montage.factory is located and type the following:

java -jar montagefactory.jar
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The montage.factory Window
The main montage.factory window on OS X looks like this

The main montage.factory window on Windows looks like this

The montage.factory user interface is a Multiple Document Interface (MDI), which allows you to have more
than one file open at a time.

The interface is divided into the now familiar layout of (from top to bottom):

The Title Bar• 
The Menu Bar (on OS X this appears at the top of the screen)• 
The Tool Bar• 
The Desktop• 
The Status Bar• 
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Menu Bar
The montage.factory menu bar provides a means of selecting common operations; typically those that affect a
complete file, or those that don't fit naturally upon a context sensitive popup menu.

Keyboard Shortcuts are provided for common operations.

montage.factory also provides context sensitive popup menus, which are accessible by right clicking over data
shown in a Child Window. Naturally the contents of the popup menus varies according to the type of data over
which the menu was popped up.

Main Menu Headings

The following menu headings are available.

montage.factory Application Menu (OS X only)• 
File Menu• 
Edit Menu• 
View Menu• 
Window Menu• 
Help Menu• 
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The Application Menu

The Application menu is available on OS X to provide a native look and feel for OS X users; some menu
options from the standard menus are migrated here (where OS X Users would expect them to be), along with
the standard OS X options for Services (none defined for montage.factory) and Window control.

About montage.factory...

Displays the montage.factory About Dialog, which provides some basic information about the program, such
as the version number.

Preferences ...

Opens the montage.factory Preferences Dialog.

Quit montage.factory

Exits the montage.factory application.

If any files have been modified and have not been saved, you will be given the option of saving them.
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The File Menu

The File menu provides the following options (OS X and Windows versions are shown):

New ...

Shows the Create New File Dialog, which allows you to create a new file.

Open ...

Shows the Open File Dialog, which allows you to open a specified file.

Save

Saves a file using its current name.

This option is only enabled if your copy of montage.factory is registered.

If the file in question is a newly created file, then the Save File Dialog is brought up to allow a name to be
entered.

Save As ...

Saves the selected file after a name has been entered in the Save File Dialog.

This option is only enabled if your copy of montage.factory is registered.

Save All

Saves all files that have been modified using their current names.

This option is only enabled if your copy of montage.factory is registered.

Open Workspace ...

This option allows you to select a previously saved Workspace, which is a Collection of open windows, and
their size and position within the main montage.factory window.

When you select this option, a dialog opens which allows you to select an montage.factory workspace file
(EXW).

Save Workspace ...

This option allows you to save the current size and position of the main montage.factory window, and the
arrangement of the open windows within montage.factory to a Workspace file.

This option is only enabled if your copy of montage.factory is registered.
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Export to

This feature is currently not supported and is disabled. It will be supported in a future version

If you select one of the export sub options in a licensed version of montage.factory, you will get the following
error dialog

Exit

This menu option is not available if the host operating system is OS X. On OSX there is a Quit menu option in
the  montage.factory Application Menu.

Exits the montage.factory application.

If any files have been modified and have not been saved, you will be given the option of saving them.

Recently Opened Files

The file menu also contains a list of recently opened files to allow easy access to files that you are currently
working upon. The recently open files list appears at the bottom of the file menu.
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The Edit Menu

The Edit menu provides the following options:

Undo

Undoes the previous edit stored in the Undo Buffer.

Redo

Redoes the next edit stored in the Undo Buffer.

Clear Undo Buffer

Clears the Undo Buffer.

Cut

Places a copy of the selected Object(s) onto the Clipboard and deletes the selected Object(s) from the file.
Note that if it is not possible to delete the object due to the synth structure, then the object is initialised (e.g. a
Performance must always have a Reverb effect).

Copy

Places a copy of the selected Object(s) onto the Clipboard.

Paste

Copies the Object(s) on the Clipboard into the highlighted location within the current file. If you cannot perform
a paste at this location (e.g. trying to copy a Live Set onto a Performance) then this menu item is disabled.

Find ...

montage.factory supports the ability to find Objects either by name or by category (where an Object supports
categories, such as Performances, Arpeggios and Waveforms).

Searches start from the currently selected Object.

Selecting the Find ... option brings up the Find dialog, that allows you to specify the string to search for, along
with options that can be used to refine the search.

Find Next

If you have defined the Find criteria within the Find dialog, then this option will repeat the search using the
same criteria.

Find Category ...

You can also search by category be selecting Find Category ... option, which brings up the Find Category
Dialog.

Find Next Category

If you have defined the Find Category criteria within the Find Category dialog, then this option will repeat the
search using the same criteria.
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Goto ...

Selecting this option brings up the Goto Dialog, which allows you to quickly navigate to a numbered Object.
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The View Menu

The View menu provides the following options; note how the menu items vary depending on the split mode:

The PC version has an addition option for displaying the Preferences... menu option .

When the Child Window is split the Left/Top Pane and Right/Bottom Pane menu options have the following
sub menu.

Tool Bar

When checked the montage.factory Tool Bar is visible.

Status Bar

When checked the montage.factory Status Bar is visible.

No Split

When checked the current Child Window is not split.

Horizontal Split

When checked the current Child Window is split horizontally.

Vertical Split

When checked the current Child Window is split vertically.

Tree

When checked the main/left/top pane in a Child Window displays data in a Tree View.

Table

When checked the main/right/bottom pane in a Child Window displays data in a Table View.
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Refresh

Refreshes all open Child Windows.

This command is provided in case the screen is not properly updated following an edit operation. There are a
couple of odd bugs I cannot track down on screen updates. So if you come across them as well, then this
command will force a redraw of the windows.

Preferences ...

This menu option is not available if the host operating system is OS X. On OSX there is a Preferences...
menu option in the  montage.factory Application Menu.

Opens the montage.factory Preferences Dialog.
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The Window Menu

The Window menu provides the following options:

In the example given above, you'll see that after the predefined menu options there are menu options that
allow you to select the windows currently open within montage.factory (Galactic Ascension.X7U and
FM-Xplorer.X7U in our example menu).

Tile Horizontal

Arranges all non-minimised Child Windows along the horizontal axis.

Tile Vertical

Arranges all non-minimised Child Windows along the vertical axis.

Maximise Windows

Maximises all Child Windows so that they all occupy the size defined by the desktop.

Restore Windows

Restores all maximised/minimised Child Windows to their normal state.

Minimise Windows

Reduces all Child Windows to their iconised state.
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The Help Menu

The Help menu provides the following options (OS X and Windows versions are shown):

Search

OS X only. This is a standard OS X Menu function currently not working with montage.factory. One day....

Get Help on montage.factory ...

Displays the montage.factory Online Help system.

View Tips and Tricks for montage.factory ...

Displays the montage.factory Tips and Tricks Dialog.

View PDF Documentation for montage.factory ...

Displays the PDF documentation for montage.factory. Note that there needs to be a registered viewer for PDF
files on your system for this command to work

View License Agreement for montage.factory ...

Displays the montage.factory License Agreement in a dialog box.

View License Agreement for montage.factory ...

Provides a link to the x.Librarian's Support Page.

About montage.factory ...

This menu option is not available if the host operating system is OS X. On OSX there is an About
montage.factory menu option in the  montage.factory Application Menu.

Displays the montage.factory About Dialog, which provides some basic information about the program, such
as the version number.

Register and Activate montage.factory ...

Displays the montage.factory registration and activation Dialog.

See the Registration Section for details of how to register montage.factory.
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Tool Bar
The Tool Bar contains buttons for common operations, such as opening and saving files.

   Displays the New File Dialog to allow you to select the type of file to create
   Displays the Open File Dialog to allow you to select a file to open

Saves the currently selected file
   Displays the Save As Dialog to allow you to select a different name for the currently selected file

Saves all the open files to disk
   Cuts the selected Objects and places them on the Clipboard
   Copies the selected Objects and places them on the Clipboard
   Pastes the contents of the Clipboard to the current selection. If you cannot perform a paste at this location

(e.g. trying to copy a Live Set Slot onto a Performance) then this menu item is disabled
Undos the previous edit
Redos the previous edit

   Displays the Find Dialog to allow you to define the search criteria and then search for the first occurence
   Searches for the next occurence of the search criteria defined in the Find Dialog
   Displays the Preferences dialog where you can configure montage.factory
   Displays the montage.factory Online Help index page
   Enables Context Sensitive Help
   Displays the Tips and Tricks Dialog
   Displays the About Dialog

The Save buttons are only enabled if montage.factory is Registered.

If the SHIFT key is held down when clicking on the    (Find) button, then the Find Category Dialog is
displayed instead.

If the SHIFT key is held down when clicking on the    (Find Next) button, then a Find Category search is
performed instead.

The Tool Bar can be dragged and made a floating toolbar by clicking and dragging the handle to the left of the
Tool Bar.

The Tool Bar can also be dragged to a different window border other than the top border.

The Tool Bar can be hidden/unhidden by the Tool Bar menu option on the View menu.

The Tool Bar whilst floating can be docked once more by closing it.
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Desktop
The Desktop portion of the window is where the Montage data is portrayed. Several files may be opened and
shown within Child Windows upon the Desktop portion of the window. The following example shows
three Child Windows open on the Desktop.

The Window Menu provides menu options to:

Tile (either vertically or horizontally) all Child Windows that are not iconised• 
Minimise all Child Windows• 
Maximise all Child Windows• 
Restore all Child Windows• 
Select a specific Child Window• 

When a file is opened, a Child Window is added to the Desktop Area.
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Child Window
The Child Window provides the View upon the data within the file it is associated with.

The Child Window is maximised by default when it is opened, and can be minimised, restored or closed by the
buttons to the right of the Child Window's title bar.

The menu options on the View menu can be used to change the View between a Tree view and a Table view,
and a Child Window can be either split horizontally or vertically split to show any of the following
combinations:

A Tree and a Table• 
A Table and a Tree• 
Two Trees• 
Two Tables• 

The default Child Window View applied when a file is opened is set in the Default View Tab of the Preferences
Dialog.

The following example shows a Child Window that is split and showing both a Tree View and a Table View on
the same data. If a file has its READ ONLY attribute set then all the file is identified as [READ ONLY] in the
window title

The Tree and Table views support drag move and drag copy operations, and the views will automatically
scroll whilst drag operations are in progress.
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Tree View

The Tree View shows the X7x data as a hierarchical tree, and can show more information than the Table
View. The following example shows a split Child Window with two Tree Views, one collapsed showing the top
level Collections, including all the available User Performance Banks, and User Motion Sequences and one
showing a Performance (U1-36 Earth Pad) that has been expanded to show more information on the
Performance; specifically Performance Part 4.

Basically, information is shown as a set of hierarchical Objects. Objects may have children attached to them,
and they themselves may have further child Objects (e.g. a Performance Object, has a child Object for all of
its Performance Parts, and this Object groups all the Performance Parts).

The basic tree structure is a Root Object at the top of the tree under which are various Object Collections
which themselves contain further data. The top level Collections that can be found under the root node varies
upon the file contents

Objects are displayed in one of three colours:

Black if the Object is not referenced by another Object• 
Blue if an Object is referenced by another Object (e.g. a Voice being used within a Performance, or a
Sample being used by a Wave)

• 

Red if the Object is "empty". Empty objects are not saved to file.• 

The Tree View allows multiple Objects to be selected, which is useful for performing operations only upon
certain Objects. You can only perform operations upon Objects of the same type.

If you wish to perform an operation upon all Objects in a Collection, simply select the Collection containing the
Objects.

If you right click over an object or selection of objects within the Tree View, a context sensitive popup menu
will appear that provides the editing operations that can be performed upon the object(s).

Objects can be Copied and Moved either within or between Child Window Views using Drag and Drop.

 The montage.factory Window 19



Table View

The Table View provides a more high level overview of the data than the Tree View, and the representation of
the data is more compact. The following example shows a Child Window with a single Table View providing
information on a file's Performances in one of the Performance Banks.

The Table View can only show one Collection of Objects at a time.

Each row within the table shows one Object.

Objects can be Copied and Moved either within or between Child Window Views using Drag and Drop.

If you right click over an object or selection of objects within the Table View, a context sensitive popup menu
will appear that provides the editing operations that can be performed upon the object(s). The cells in a Row
that contain the Object Category and Object Name (if available) can be directly edited by clicking in them.

The context menu also provides the options to select what data view. In the example below, the table is
currently showing the Performance U1 Bank, but a selection is being made via the menu to change to the
Performance U2 Bank.
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You can also double click a high level collection (e.g. Performance Bank Collection, Performance Banks) and
montage.factory will move down to the next level until you get to discrete objects (e.g. Performances). You
can double click with the ALT key (OPTION key on OS X) held down to traverse upwards.
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Status Bar

The Status Bar provides the following pieces of information (from left to right) for the Child Window which is
currently selected:

The name of the file currently open, if any. If no file has been selected then this field is blank• 
The type of the file• 
Whether or not the file has been modified• 
If the left/top split pane is a table this indicator identifies what the table is showing (Performances,
Waves, etc.)

• 

If the right/bottom split pane is a table this indicator identifies what the table is showing
(Performances, Waves, etc.)

• 
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montage.factory Program Features
montage.factory provides the following features:

File Operations• 
Undo/Redo Support• 
Clipboard Support• 
Find and Goto Support• 
Editing Features• 
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File Operations
montage.factory supports the following file operations:

Create New Files• 
Open Existing Files• 
Save Files• 
Open and Save Workspaces• 
Export Data• 
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Create New File

When the New File ... option from the File Menu or the  button on the Toolbar is selected, the following
dialog is shown:

The dialog, allows you to select the type of file to create from the following

Montage User File (type X7U)• 
Montage Library File (type X7L)• 
MODX User File (type X8U)• 
MODX Library File (type X8L)• 

Back up files are not yet supported I will add support for those in a later version.

The dialog, allows you to select the banks which are created from the following

Live Sets• 
Performances• 
Arpeggios• 
Audition Phrases• 
Waves• 
Motion Sequences• 
Microtunings• 
Curves• 
System (Utility Settings)• 
Libraries• 

You can use the All or None buttons to quick set or clear all tick boxes.

You can set the default options for the data that you wish to create in the New File Preferences in
the Preferences dialog.

The new data file is given a name in the form of "montageFactory_n", where n is a number that increments
every time a file is created.

Note, this is different from initialising data in a file, as a totally new file is created.

Note, only the creation of 3.x file formats is supported in this release of montage.factory. If there is sufficient
demand, I may add support for the creation of earlier, legacy X7x file formats.
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Open Existing File

When the Open ... option from the File menu or the  button on the Toolbar is selected, the following dialog
will appear allowing a file to be selected.

Only X7L and X7U files are currently supported for loading. X7A and X8A files will be supported in later
versions.

montage.factory checks to ensure that the selected file is a valid Montage format file, and an error dialog will
appear if the file is not valid.

If a file selected for opening is already open, montage.factory will ask if you want to replace the file that is in
memory.

If a file has its READ ONLY attribute set then all editing features are disabled. You can still copy data from the
file using a drag copy operation or a Clipboard copy operation. The file is identified as [READ ONLY] in the
window title.
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Save Open Files

The saving of files is only available if montage.factory is registered.

When you save a file to disk using: the Save As ... command from the File Menu, or when a file created using
the New ... command from the File Menu is saved for the first time, the following dialog appears to allow you
to select a name for the file.
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Workspaces

montage.factory allows you to save the current size and position of the main montage.factory window, and the
arrangement of the open Child Windows within montage.factory to a file known as a Workspace.

This allows you to save a Workspace you are using for future recall at a later date.

The following parameters for each Child Window are remembered:

Window size, position and status (normal, maximised or minimised)• 
Horizontal/Vertical Splits, including split position• 
Pane type(s) (e.g. Tree, Voice Table or Performance Table)• 
Tree node expansion status• 
Table column widths• 
Scroll position of the pane(s)• 
Selection state of the tree nodes, or table rows• 
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Undo Buffer
montage.factory supports a multi-level Undo/Redo Buffer facility on all edits.

The number of edits which can be stored is 100.

The Undo/Redo commands can be found both within the Edit Menu, and on the Toolbar.

Please note that the undo buffer is global across all open files, and is cleared when any file is closed. This
may be improved in later releases.

The undo buffer can be cleared by the selecting the Clear Undo Buffer option on the Edit Menu. The
intention of this feature is to help cope with low memory situations, as it will free up the memory used by
stored edits.
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Clipboard Support
The clipboard works just like the clipboard in other applications. It allows you to place an Object or a copy of
an Object upon the clipboard and then paste that Object elsewhere within a file or another file.

You can Cut/Copy either a single Object or a Collection of Objects onto the clipboard.

You can only paste from the clipboard to the current location in a file if it makes sense to do so. For example:

You cannot paste a Performance onto a Wave• 
You cannot paste ten Performances at the end of a Performance Bank if the selection is at
Performance 120 or higher

• 

The clipboard is "local" to the application, and only Objects can be placed upon it.

montage.factory does not support the system clipboard so it is not possible to cut and paste between and
other applications. I don't think this is a major drawback because I cannot think of any circumstances where
you would wish to do this!
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Find and Goto Facilities
Find Dialog

montage.factory supports the ability to find Objects either by name or by category (where an Object supports
categories, such as Performances).

Searches start from the currently selected Object.

Selecting the Find ... option on the Edit Menu brings up the Find dialog, that allows you to specify the string to
search for. In addition there are several options that can be selected

Find What The text string to search for.
Match Case If this option is checked then the search is case sensitive. If this option is not checked then

the search is case insensitive.
Match Whole
Name

If this option is checked then the search string must match the entire name of an Object.
E.g. "pan" would match a Performance called "pan", but not a Performance called
"pandora". If this option is not checked then the search can match a sub string within a
name. E.g. "dor" would match a Performance named "dor" and a Performance called
"pandora".

Use Wild Cards If checked, montage.factory will treat the "Find What" text as a "regular expression" to
allow you more control over the search, such as matching text at the start of a name, or the
end of a name, words with numbers in, etc.

The regular expression language used for montage.factory wild card support is the Perl Regular Expression
Syntax. Rather than try and write up this powerful syntax myself into the montage.factory documents, I'll direct
you to the Perl Regular Expression Syntax page for a description of how to use this powerful feature.

Find Category Dialog

You can also search by category be selecting Find Category ... option on the Edit Menu, which brings up the
Find Category Dialog.

This option allows you to search, for example, for all string Performances in a file (assuming all Performances
have been assigned a category). Note: only some Objects (such as Performances and Waves) have a
category value.

Simply select the Category from the "Find Category" combo box that you wish to search for, and that's all
there is to it.

 montage.factory Program Features 31

http://www.perl.com/doc/manual/html/pod/perlre.html


Goto Dialog

Selecting this option on the on the Edit Menu brings up the Goto Dialog

Item Type The type of Object to go to

The list of types of Objects that can be selected depends upon the contents of
the file.

• 

If a Table View is selected then you can only go the type of objects shown by the
Table

• 

Item Number The number of the Object to go to.
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Editing Features
montage.factory supports the following editing features:

Note that if a file has its READ ONLY attribute set then all editing features are disabled. You can still copy
data from the file using a drag copy operation or a Clipboard copy operation. The file is identified as [READ
ONLY] in the window title.

General Editing Features• 
Synth Editing Features• 
Live Set Editing Features• 
Performance Editing Features• 
Arpeggio Editing Features• 
Audition Phrase Features• 
Wave Editing Features• 
Motion Sequence Editing Features• 
Microtuning Editing Features• 
Curve Editing Features• 
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General Editing Features

montage.factory supports many editing features, some of which are classed as general features that are
applicable to all or most Objects.

The general features are described here in one place for convenience:

Copy/Move Object• 
Initialise Object• 
Rename Object• 
Insert Object• 
Delete Object• 
List Object References• 
Sort Objects• 
Export Objects• 
Add Objects to Library (note this will be added in a later version)• 
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Copy/Move Object

montage.factory makes extensive use of drag and drop for copying and moving Objects.

You can drag copy or move Objects within a file or between files, and you can drag single items or multiple
items.

The default drag operation is to move an Object, and there are two types of move operations:

Moving an Object within its Parent Collection (e.g. moving a Performance from location 1 to location
4)

• 

Moving an Object to a new Parent Collection (e.g. moving a Performance from one file to another file)• 

When you move an Object to a new Parent Collection then the original Object is removed and replaced with
an initialised Object of the same type.

To copy an Object using drag and drop, you must have the DRAG MODIFIER key held down during the
operation. The DRAG MODIFIER key is platform dependent. On the PC platform it is the CTRL key.

You can tell that a copy operation is in progress as the drag image icon has a + sign visible.

When you drag multiple items they must be of the same type. For example you can drag several
Performances, but not Performances and Waves together.

montage.factory provides the following drag/drop feedback to assist in determining the effects of a drag/drop
operation:

Cursor: Indicates if the move is either a copy or a move, or if the drop is invalid (e.g. trying to drag a
Performance onto a Wave)

• 

Drag image: A simple pictorial representation of what is being dragged• 
Drop Point: montage.factory shows the drop point as either a cue line drawn between Objects if an
Object is being moved within its parent (e.g. a Live Set Page within a Live Set), or a cue rectangle
drawn around the drop location for all other moves and copy operations which are valid

• 

When a Child Window is split, Objects can be dragged and dropped between either side of the split point. This
is handy, for example, for dragging Objects between the start of a Collection and the end of a Collection.

The Tree and Table views will auto-scroll in drag and drop operations, when you move the cursor to either the
top or the bottom of the pane and hold it there.

If you drag an Object onto a Tree View and over a valid parent Object (e.g. a Performance Part over a
Performance) and the parent Object is collapsed within the Tree, and you hold the cursor over the Parent
Object for a few seconds it will automatically expand.

montage.factory will maintain the references to Objects in a Collection when moving Objects within a file, as
follows:

Collection Type Objects Updated
Performance Live Set Slots
Arpeggio Performance Part Arpeggio slots
Audition Phrases Performances
Wave Performance Part AWM2 Elements
Motion Sequence Performances
Microtuning Performance Parts
Curves Performances

Motion Sequences
For example if you move a Performance within a X7x file Performance Bank from Location 2 to Location 10,
then any Live Set Slots which are referencing Performances at Locations 2 and above will be updated to
ensure they still reference the same Performances after the move operation as they were before the move
operation.

The ability to update references following a move or to copy referenced Objects during a move to a new file
can be selectively turned on or off within the Preferences Dialog.

Initialise Object

Initialises the selected Object to its default state.

Multiple Objects of the same type can be selected for initialisation.

The Initialise command is found upon the Context Sensitive Menu in both the Tree View and the Table
View.
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Rename Object

Renames the selected Object using the following dialog:

Only one Object can be selected for renaming.

The dialog will provide drop down lists for selecting a Category and Sub Category values for Objects that
support them:

Object Type Category? Sub Category?
Live Set Slot No No
Program Yes Yes
Arpeggio Yes Yes
Audition Phrase No No
Wave Yes Yes
Motion Sequence No No
Microtuning No No
Curve No No
The Rename command is found upon the Context Sensitive Menu in the Tree View

To rename Objects in the Table View, simply click in Category Cell of the required Object to select the
Category value from a drop down list, or double click in the Name Cell of the required Object to edit the name.

Insert Object

Inserts an Object into a Collection at the current location.

The Insert command is found upon the Context Sensitive Menu in both the Tree View and the Table View.

You can insert more than one Object at a time by selecting multiple Objects prior to executing the Insert
command.

For example if you wish to insert three Performances at location 10, select Performances 10, 11 and 12 and
then execute the Insert command.

Note that when you insert one or more Objects, then the commensurate number of Objects at the end of the
Parent Collection are removed if required. This is necessary to maintain the correct number of Objects in a
Collection.

For example, a Performance Bank Collection in an X7x file can only contain 128 Perofrmances, so if two
Performances are inserted into the Collection then two Performances must be removed from the end of the
Collection to maintain the correct size.

montage.factory will maintain the references to Objects in a Collection when inserting Objects, as follows:
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Collection Type Objects Updated
Performance Live Set Slots
Arpeggio Performance Part Arpeggio slots
Audition Phrases Performances
Wave Performance Part AWM2 Elements
Motion Sequence Performances
Microtuning Performance Parts
Curves Performances

Motion Sequences
For example if you insert a Performance into an X7x file Performance Bank at Location 10, then any Live Set
Slots which are referencing Performances in the bank at Locations 10 and above will be updated to ensure
they still reference the same Performances after the insert operation as they were before the insert operation.

Delete Object

Deletes an Object at the current location.

The Delete command is found upon the Context Sensitive Menu in both the Tree View and the Table View.

You can delete more than one Object at a time by selecting multiple Objects prior to executing the Delete
command.

For example if you wish to delete three Performances at location 10, select Performances 10, 11 and 12 and
then execute the Delete command.

Note that when you delete one or more Objects, then a commensurate number of Objects at the end of the
Parent Collection are added if required. This is necessary to maintain the correct number of Objects in a
Collection.

For example, a Performance Bank Collection in a X7x file must contain 128 Voices, so if two Performances
are deleted from the Collection then two Performances must be added to the end of the Collection to maintain
the correct size.

montage.factory will maintain the references to Objects in a Collection when deleting Objects, as follows:

Collection Type Objects Updated
Performance Live Set Slots
Arpeggio Performance Part Arpeggio slots
Audition Phrases Performances
Wave Performance Part AWM2 Elements
Motion Sequence Performances
Microtuning Performance Parts
Curves Performances

Motion Sequences
For example if you delete a Performance from an X7x Performance Bank at Location 10, then any Live Set
Slot which are referencing Performances in that Bank at Locations 10 and above will be updated to ensure
they still reference the same Performances after the delete operation as they were before the delete
operation.

List Object References

The List References command is found upon the Context Sensitive Menu in both the Tree View and
the Table View.

The List References command is only available if:

Only one Object is selected• 
The Object selected is referenced by another Object, which is indicated by the Object being coloured
blue

• 

The references are shown as follows:
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The Object being referenced is shown at the top of the Dialog followed by the Objects referencing it.

Sort Objects

The Sort command is found upon the Context Sensitive Menu in both the Tree View and the Table View.

The type of sort operations available depend upon the types of Object being sorted:

Object Type Sort by Name Sort By Category
Live Set Bank Yes No
Live Set Bank Page Yes No
Live Set Bank Page Slots No No
Performances Yes Yes
Arpeggios Yes Yes
Audition Phrases Yes No
Waves Yes Yes
Motion Sequences Yes No
Microtunings Yes No
Curves Yes No
In the Tree View the sort options are accessed via the Context Sensitive Menu for the Collection that you
wish to sort (e.g. a Performance Bank Collection to sort Performances).

In the Table View the sort options are accessed via the Context Sensitive Menu for any Object. The sort can
also be initiated by clicking in the Category or Name column headers.

montage.factory will maintain the references to Objects in a Collection when inserting Objects, as follows:

Collection Type Objects Updated
Performance Live Set Slots
Arpeggio Performance Part Arpeggio slots
Audition Phrases Performances
Wave Performance Part AWM2 Elements
Motion Sequence Performances
Microtuning Performance Parts
Curves Performances

Motion Sequences
Synth Editing Features

montage.factory supports the following editing operations upon the Synth Object within the Tree View of
a Child Window:

Move• 
Copy• 
Initialise• 
Add - If not all main collections are present in the file (e.g. Performance Banks, Waves, etc.) then this
menu will be present allowing you to add in the items that are not present

• 

Cut to Clipboard• 
Copy to Clipboard• 
Paste from Clipboard• 

To access these features, right click over the Synth Object to activate the Synth Object's Context Sensitive
Menu.

The Synth Object is only shown within a Tree View and is the first Object in the Tree View.
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Live Set Editing Features

Live Set Bank Collection Editing Features

montage.factory supports the following editing operations upon the Live Set Bank Collection shown within
the Tree View or Table View of a Child Window:

Copy/Move• 
Initialise• 
Delete• 
Sort by Name• 
Cut to Clipboard• 
Copy to Clipboard• 
Paste from Clipboard• 

To access all features other than Move and Copy (which you do via "Drag and Drop"), right click over the Live
Set Bank Collection to activate the Live Set Bank Collection's Context Sensitive Menu.

Live Set Bank Editing Features

montage.factory supports the following editing operations upon the Live Set Banks shown within the Tree
View or Table View of a Child Window:

Copy/Move• 
Rename• 
Initialise• 
Insert• 
Delete• 
Sort by Name• 
Cut to Clipboard• 
Copy to Clipboard• 
Paste from Clipboard• 

To access all features other than Move and Copy (which you do via "Drag and Drop"), right click over the Live
Set Bank to activate the Live Set Bank's Context Sensitive Menu.

Live Set Bank Page Editing Features

montage.factory supports the following editing operations upon the Live Set Bank Pages shown within
the Tree View or Table View of a Child Window:

Copy/Move• 
Rename• 
Initialise• 
Insert• 
Delete• 
Sort by Name• 
Cut to Clipboard• 
Copy to Clipboard• 
Paste from Clipboard• 

To access all features other than Move and Copy (which you do via "Drag and Drop"), right click over the Live
Set Bank Page to activate the Live Set Bank Page's Context Sensitive Menu.

Live Set Bank Page Slot Editing Features

montage.factory supports the following editing operations upon the Live Set Slot Bank Page Slot Objects
within the Tree View or Table View of a Child Window:

Copy/Move• 
Initialise• 
Rename• 
Insert• 
Delete• 
Cut to Clipboard• 
Copy to Clipboard• 
Paste from Clipboard• 

To access all features other than Move and Copy (which you do via "Drag and Drop"), right click over a Live
Set Bank Page Slot or selection of Live Set Bank Page Slots to activate the Live Set Bank Page Slot's
Context Sensitive Menu.

You can DRAG COPY Performances onto Live Set Slots to set the references to them.
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Performance Editing Features

Performance Bank Collection Editing Features

montage.factory supports the following editing operations upon the Performance Bank Collection shown
within the Tree View or Table View of a Child Window:

Copy/Move• 
Initialise• 
Delete• 
Cut to Clipboard• 
Copy to Clipboard• 
Paste from Clipboard• 

To access all features other than Move and Copy (which you do via "Drag and Drop"), right click over the
Performance Collection to activate the Performance Collection's Context Sensitive Menu.

Performance Bank Editing Features

montage.factory supports the following editing operations upon the Performance Banks shown within
the Tree View or Table View of a Child Window:

Copy/Move• 
Initialise• 
Delete• 
Sort by Name• 
Sort by Category• 
Cut to Clipboard• 
Copy to Clipboard• 
Paste from Clipboard• 

To access all features other than Move and Copy (which you do via "Drag and Drop"), right click over the
Performance Collection to activate the Performance Collection's Context Sensitive Menu.

Performance Editing Features

montage.factory supports the following editing operations upon the Performance Objects within the Tree
View or Table View of a Child Window:

Copy/Move• 
Initialise• 
Rename• 
Insert• 
Delete• 
New... - allows you to create new AWM, FM-X or Drum Performances.• 
List References• 
Cut to Clipboard• 
Copy to Clipboard• 
Paste from Clipboard• 

To access all features other than Move and Copy (which you do via "Drag and Drop"), right click over a
Performance or selection of Performances to activate the Performance's Context Sensitive Menu.

Remember that the category and sub category of a performance are set from the category and sub category
of the first part. If you edit the category and sub category of the performance then the first part is also
updated. If you edit the category and sub category of the first performance part then the performance is also
updated.

In the Tree View you can drill down further into the structure of a Performance. All objects will support:

Copy/Move• 
Initialise• 
Cut to Clipboard• 
Copy to Clipboard• 
Paste from Clipboard• 

Where there are several similar objects in a list (e.g. Insert Effects, etc.) then the following options are also
available.

Insert• 
Delete• 

You can DRAG COPY a single Performance onto a Live Set Slot to set the reference to the Performance.
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You can DRAG COPY a single Wave onto a Performance Part AWM Element to set the reference to the
Wave

Performance Part Collection Editing Features

The following options are also available for the Performance Part Collection within the Tree View.

Add allows you to add additional AWM, FM-X or Drum Parts to the collection up to the maximum
allowed count. If you hold down the ALT key (OPTION key on OSX) whilst making the menu
selection, a dialog is opened that allows you to specify the number of parts to add.

• 

Performance Part Editing Features

The following options are also available for Performance Parts within the Tree View.

Rename• 
New allows you to replace the current part with a new AWM, FM-X or Drum Part.• 

Remember that the category and sub category of a performance are set from the category and sub category
of the first part. If you edit the category and sub category of the performance then the first part is also
updated. If you edit the category and sub category of the first performance part then the performance is also
updated.

Arpeggio Editing Features

montage.factory supports the following editing operations upon the Arpeggio Collection shown within
the Tree View or Table View of a Child Window:

Copy/Move• 
Initialise• 
Delete• 
Sort by Name• 
Sort by Category• 
Cut to Clipboard• 
Copy to Clipboard• 
Paste from Clipboard• 

To access all features other than Move and Copy (which you do via "Drag and Drop"), right click over the
Arpeggio Collection to activate the Arpeggio Collection's Context Sensitive Menu.

montage.factory supports the following editing operations upon the Arpeggio Objects within the Tree View
or Table View of a Child Window:

Copy/Move• 
Rename• 
Initialise• 
Insert• 
Delete• 
List References• 
Cut to Clipboard• 
Copy to Clipboard• 
Paste from Clipboard• 

To access all features other than Move and Copy (which you do via "Drag and Drop"), right click over a
Arpeggio or selection of Arpeggios to activate the Arpeggio's Context Sensitive Menu.

You can DRAG COPY a single Arpeggio onto an Performance Part Areggio Element, to set the reference to
the Arpeggio.

Audition Phrase Editing Features

montage.factory supports the following editing operations upon the Audition Phrase Collection shown within
the Tree View or Table View of a Child Window:

Copy/Move• 
Initialise• 
Delete• 
Sort by Name• 
Cut to Clipboard• 
Copy to Clipboard• 
Paste from Clipboard• 

To access all features other than Move and Copy (which you do via "Drag and Drop"), right click over the
Audition Phrase Collection to activate the Audition Phrase Collection's Context Sensitive Menu.
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montage.factory supports the following editing operations upon the Audition Phrase Objects within the Tree
View or Table View of a Child Window:

Copy/Move• 
Rename• 
Initialise• 
Insert• 
Delete• 
List References• 
Cut to Clipboard• 
Copy to Clipboard• 
Paste from Clipboard• 

To access all features other than Move and Copy (which you do via "Drag and Drop"), right click over a
Audition Phrase or selection of Audition Phrases to activate the Audition Phrase's Context Sensitive
Menu.

Wave Editing Features

montage.factory supports the following editing operations upon the Wave Collection shown within the Tree
View or Table View of a Child Window:

Copy/Move• 
Initialise• 
Delete• 
Sort by Name• 
Sort by Category• 
Cut to Clipboard• 
Copy to Clipboard• 
Paste from Clipboard• 

To access all features other than Move and Copy (which you do via "Drag and Drop"), right click over the
Wave Collection to activate the Wave Collection's Context Sensitive Menu.

montage.factory supports the following editing operations upon the Wave Objects within the Tree View
or Table View of a Child Window:

Copy/Move• 
Rename• 
Initialise• 
Insert• 
Delete• 
List References• 
Cut to Clipboard• 
Copy to Clipboard• 
Paste from Clipboard• 

To access all features other than Move and Copy (which you do via "Drag and Drop"), right click over a Wave
or selection of Waves to activate the Wave's Context Sensitive Menu.

You can DRAG COPY a single Wave onto an AWM Performance Part Element, to set the reference to the
Wave.

Motion Sequence Editing Features

montage.factory supports the following editing operations upon the Motion Sequence Collection shown
within the Tree View or Table View of a Child Window:

Copy/Move• 
Initialise• 
Delete• 
Sort by Name• 
Cut to Clipboard• 
Copy to Clipboard• 
Paste from Clipboard• 

To access all features other than Move and Copy (which you do via "Drag and Drop"), right click over the
Motion Sequence Collection to activate the Motion Sequence Collection's Context Sensitive Menu.

montage.factory supports the following editing operations upon the Motion Sequence Objects within
the Tree View or Table View of a Child Window:

Copy/Move• 
Rename• 
Initialise• 
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Insert• 
Delete• 
List References• 
Cut to Clipboard• 
Copy to Clipboard• 
Paste from Clipboard• 

To access all features other than Move and Copy (which you do via "Drag and Drop"), right click over a
Motion Sequence or selection of Motion Sequences to activate the Motion Sequence's Context Sensitive
Menu.

Microtuning Editing Features

montage.factory supports the following editing operations upon the Microtuning Collection shown within
the Tree View or Table View of a Child Window:

Copy/Move• 
Initialise• 
Delete• 
Sort by Name• 
Cut to Clipboard• 
Copy to Clipboard• 
Paste from Clipboard• 

To access all features other than Move and Copy (which you do via "Drag and Drop"), right click over the
Microtuning Collection to activate the Microtuning Collection's Context Sensitive Menu.

montage.factory supports the following editing operations upon the Microtuning Objects within the Tree View
or Table View of a Child Window:

Copy/Move• 
Rename• 
Initialise• 
Insert• 
Delete• 
List References• 
Cut to Clipboard• 
Copy to Clipboard• 
Paste from Clipboard• 

To access all features other than Move and Copy (which you do via "Drag and Drop"), right click over a
Microtuning or selection of Microtunings to activate the Microtuning's Context Sensitive Menu.

Curve Editing Features

montage.factory supports the following editing operations upon the Curve Collection shown within the Tree
View or Table View of a Child Window:

Copy/Move• 
Initialise• 
Delete• 
Sort by Name• 
Cut to Clipboard• 
Copy to Clipboard• 
Paste from Clipboard• 

To access all features other than Move and Copy (which you do via "Drag and Drop"), right click over the
Curve Collection to activate the Curve Collection's Context Sensitive Menu.

montage.factory supports the following editing operations upon the Curve Objects within the Tree View
or Table View of a Child Window:

Copy/Move• 
Rename• 
Initialise• 
Insert• 
Delete• 
List References• 
Cut to Clipboard• 
Copy to Clipboard• 
Paste from Clipboard• 

To access all features other than Move and Copy (which you do via "Drag and Drop"), right click over a Curve
or selection of Curves to activate the Curve's Context Sensitive Menu.
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Preferences
V1.0 note: Some options listed here are for future program features, so may have no effect in V1.0

The montage.factory preferences are accessed via the Preferences ... option on the View menu or the
montage.factory Application Menu on OS X, or the  button on the Toolbar.

Selecting this option opens a Tabbed dialog with the following tabs which group related parameters:

Live Set Preferences• 
Performance Preferences• 
Motion Sequence Preferences• 
New File Preferences• 
Montage Libraries Preferences• 
Default View Preferences• 
Miscellaneous Preferences• 

To view and modify a set of parameters, click on the relevant tab.

Note: The options to update Objects following an Object move within the same file (e.g. Update
Performances after Wave Move) also apply when Objects that can be referenced are inserted, deleted and
sorted.

Note: The options to copy referenced Objects with "parent" Objects (e.g. moving Performances with Live
Sets) work by:

Checking the destination file to see if the referenced Object exists• 
If it does then the parent Object is updated after being moved to point to the existing Object in the
destination file

• 

If not then montage.factory checks to see if a blank or empty child Object is present in the destination
file (e.g. in the case of moving a Performance, a blank "INIT PROGRAM" is looked for)

• 

If a blank Object is found then the child Object is copied and the parent Object is updated after being
moved to point to the new Object in the destination file

• 

If no blank Object is found the montage.factory gives up. Note this may result in a Partial edit (e.g. it
may have only been possible to copy a subset of Objects due to the amount of free Objects in the
destination file)

• 

The child Objects are only ever copied irrespective of whether the parent Object is being moved or
copied. This is to avoid the problem that would occur when a child Object is moved (say a
Performance with Live Set Bank 1), where the source child Object (which would have been initialised
after the move) is also referenced by other Parent Objects (e.g. another Live Set)

• 

All the above options are sensitive to what is being dragged. For example a Live Set Bank Page Slot, Live Set
Bank Page, Live Set Bank, Live Set Banks Branch can be dragged and the necessary Objects will be copied

Finally, it's worth noting that if the options are all set then everything needed is copied. For example if you
drag a Live Set to a new file, then potentially, Performances used in the Live Set Slots, Wave used by the
Performances, etc are all copied. This is a feature I've long been desperate for!
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Live Set Preferences
The Live Set Preferences tab is shown below:

This tab has the following options:

Update Live Sets After
Performance Move

If you move Performances within a X7x file then the Live Sets that
reference the updated Performances are updated to ensure that the
correct references to the Performance are maintained.

Update Live Sets After Pattern
Move

If you move a Pattern within an associated X7A file then the Live Sets
that use Patterns are updated to ensure that the correct references to
the Patterns are maintained.

Update Live Sets After Song
Move

If you move a Song within an X7A file then the Live Sets that use Songs
are updated to ensure that the correct references to the Songs are
maintained.

Copy Performances With Live Set If you move or copy a Live Set from one file to another file, then any
Performances referenced by the Live Set are also copied to the
destination file if the Performances are not already present in the
destination file.

Copy Patterns With Live Set If you move or copy a Live Set from one X7A file to another X7A file,
then any Patterns referenced by the Live Set are also copied to the
destination file if the Patterns are not already present in the destination
file.

Copy Songs With Live Set If you move or copy a Live Set from one X7x file to another X7x file, then
any Songs referenced by the Live Set are also copied to the destination
file if the Songs are not already present in the destination file.
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Performance Preferences
The Performance Preferences tab is shown below:

This tab has the following options:

Update Performances After Wave
Move

If you move a Wave within a file then the Performances that use the
Wave are updated to ensure that the correct references to the Wave are
maintained.

Update Performances After
Arpeggio Move

If you move an Arpeggio within a file then the Performances that use the
Arpeggio are updated to ensure that the correct references to the
Arpeggio are maintained.

Update Performances After
Motion Sequence Move

If you move a Motion Sequence within a file then the Performances that
use the Motion Sequence are updated to ensure that the correct
references to the Motion Sequence are maintained.

Update Performances After
Microtuning Move

If you move a Microtuning within a file then the Performances that use
the Microtuning are updated to ensure that the correct references to the
Microtuning are maintained.

Update Performances After
Curve Move

If you move a Curve within a file then the Performances that use the
Curve are updated to ensure that the correct references to the Curve are
maintained.

Update Performances After
Audition Phrase Move

If you move an Audition Phrase within a file then the Performances that
use the Wave are updated to ensure that the correct references to the
Audition Phrase are maintained.

Copy Waves With Performance If you move or copy a Performance from one X7x file to another X7x file,
then any Waves referenced by the Performance are also copied to the
destination file if the Waves are not already present in the destination
file.

Copy Arpeggios With
Performance

If you move or copy a Performance from one X7x file to another X7x file,
then any Arpeggios referenced by the Performance are also copied to
the destination file if the Arpeggios are not already present in the
destination file.

Copy Motion Sequences With
Performance

If you move or copy a Performance from one X7x file to another X7x file,
then any Motion Sequences referenced by the Performance are also
copied to the destination file if the Motion Sequences are not already
present in the destination file.

Copy Microtunings With
Performance

If you move or copy a Performance from one X7x file to another X7x file,
then any Microtunings referenced by the Performance are also copied to
the destination file if the Microtunings are not already present in the
destination file.

Copy Curves With Performance If you move or copy a Performance from one X7x file to another X7x file,
then any Curves referenced by the Performance are also copied to the
destination file if the Curves are not already present in the destination
file.
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Copy Audition Phrases With
Performance

If you move or copy a Performance from one X7x file to another X7x file,
then any Audition Phrases referenced by the Performance are also
copied to the destination file if the Audition Phrases are not already
present in the destination file.
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Motion Sequence Preferences
The Motion Sequence Preferences tab is shown below:

This tab has the following options:

Update Motion Sequences After
Curve Move

If you move a Curve within a file then the Motion Sequences that use the
Curve are updated to ensure that the correct references to the Curve are
maintained.

Copy Curves With Motion
Sequence

If you move or copy a Motion Sequence from one X7x file to another X7x
file, then any Curves referenced by the Motion Sequence are also
copied to the destination file if the Curves are not already present in the
destination file.
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New File Preferences
The New File Preferences tab is shown below:

This tab allows you to set the default options that will be used when you select the New File ... option from
the File Menu or the  button on the Toolbar.

This dialog, allows you to select the banks which are created from the following

Live Sets• 
Performances• 
Arpeggios• 
Audition Phrases• 
Waves• 
Motion Sequences• 
Microtunings• 
Curves• 
System (Utility Settings)• 
Libraries• 

You can use the All or None buttons to quick set or clear all tick boxes.
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Montage Libraries Preferences
The Montage Libraries Preferences tab is shown below:

This tab allows you to specify the libraries that you have loaded in your Montage. This allows montage.factory
to show what the references to library data in X7x files are. For example you might have a Live Set pointing to
a mix of preset, user and library performances. If no reference library data is available, then all the Montage
can show is the library and performance number, but if library data is available then things like Performance
name and category can be shown.

Library File List The list of files that you have loaded into your library slots.
Get From File ... The Montage saves library information in X7X files. So, for example, if

you save an X7U file, copy it to your computer then you can use this
option to select the file and montage.factory will read your current
libraries to save you having to enter them yourself.
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Default View Preferences
The Default View Preferences tab is shown below:

Default View Defines the type of view that is applied to a Child Window when it is first
opened.

The following options are available:

No Split• 
Horizontal Split• 
Vertical Split• 

Pane/Left Pane/Top Pane Defines the type of view shown in the single pane of an unsplit view, the
left pane of a horizontally split view or the top pane of a vertically split
view.

The following options are available:

Tree View• 
Table View• 

Right Pane/Bottom Pane This control is only visible if the Default View option is set to either
Horizontal Split or Vertical Split.

Defines the type of view shown in the right pane of a horizontally split
view or the bottom pane of a vertically split view.

The following options are available:

Tree View• 
Table View• 
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Default Library View Defines the type of view that is applied to the Montage Library Window
when it is first opened.

The following options are available:

No Split• 
Horizontal Split• 
Vertical Split• 

Library Pane/Library Left
Pane/Library Top Pane

Defines the type of view shown in the single pane of an unsplit view, the
left pane of a horizontally split view or the top pane of a vertically split
view.

The following options are available:

Tree View• 
Table View• 

Library Right Pane/Library
Bottom Pane

This control is only visible if the Default Library View option is set to
either Horizontal Split or Vertical Split.

Defines the type of view shown in the right pane of a horizontally split
view or the bottom pane of a vertically split view.

The following options are available:

Tree View• 
Table View• 

View Tool Bar Controls if the toolbar is visible at startup.
View Status Bar Controls if the status bar is visible at startup.
View Backdrop In Child Window This option controls if the image backdrop is displayed in Child Windows.

You may wish to turn off this option if you find the scrolling of the Child
Window is slow on your machine.
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Miscellaneous Preferences
The Miscellaneous Preferences tab is shown below:

This tab has the following options:

Startup Directory Allows the startup directory to be specified. Note: no validation is
performed on this pathname, so please ensure it is valid. I may add
validation later.

The [...] button to the right of the field brings up a dialog that allows you
to select the directory instead of typing it in.

Wave Load Options Note: This option is currently ignored. It will be used in later
versions, and can be ignored for now.

Determines what montage.factory does with Waves when loading X7x
files. You can select the behaviour from the following choices:

No  - Wave files are not loaded• 
Yes - Wave files are automatically loaded• 
Confirm - montage.factory asks you if you wish to load a wave
file

• 

Load Last File On Startup Controls if the last file opened in the previous session is automatically
loaded when montage.factory is next invoked.

Check For Duplicates When
Moving or Copying Objects

If you move or copy an Object to a destination file and the Object already
exists then a warning is presented giving you the option to continue or
cancel the operation.

Warn if Destination Object is
Referenced When Moving or
Copying Objects

If you move or copy an Object and it is overwriting an Object that is
being referenced, or you are deleting a referenced Object, then a
warning is presented giving you the option to continue or cancel the
operation.

Create Library File on File
Open/Save

Creates JSON files that describe the structure of the file when a file is
first opened and then each time it is save within montage.factory. These
files can be found in the
/xfactory.librarians/montage.factory/synth.libraries folder under your user
folder. The files are used by montage.factory to show the contents of
files that are identified as libraries in a Montage file, but (if you
understand a bit of JSON) you can also use it for your own purposes like
making catalogues for your own use.
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Online Help
montage.factory provides a full online version of the montage.factory manual.

If you select Help ... from the Help Menu or the  button on the Tool Bar, the Help Window is opened.

The Help Window works just like a web browser window, so its operation should be quite familiar to you.

The left pane of the Help Window shows a tabbed navigation pane to allow you to quickly navigate to a topic,
whilst the right hand pane shows the help topic.

The navigation pane can show three different views, depending on which tab you select:

   Displays the Table of Contents Navigation Pane, providing a structured list of montage.factory
topics

• 

   Displays the Index Navigation Pane, providing an indexed list of montage.factory topics• 
   Displays the Search Navigation Pane, allowing you to search the help topics for keywords• 

The Help Window has the following Tool Bar buttons:

   Navigates backwards to the last page in the access sequence. If you press and hold the mouse
button over this button, you will get a list of accessed pages

• 

   Navigates forwards to the next page in the access sequence. If you press and hold the mouse
button over this button, you will get a list of accessed pages

• 

   Selects the home page• 
    Refreshes the current page• 
    Prints the current page• 
    Displays the print settings dialog• 

Context Sensitive Help
You can access context sensitive help by:

pressing the your Computer Platform's Help Key ( F1 on the PC platform), which will load the help
page associated with the Component within the montage.factory Window that currently has Focus (is
responding to the keyboard and mouse).

• 

pressing the  button on the Tool Bar and the clicking over the item of interest• 

You can press the Help Key in any montage.factory Dialog to access the relevant help page for the Dialog.
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Tips and Tricks
The montage.factory tips and tricks dialog is shown below:

This dialog has the following controls:

Close Closes the Tips and Tricks Dialog
Next Tip Selects the next tip in sequence
Show Tips at
Startup

If checked then when montage.factory starts up, the Tips and Tricks Dialog is
automatically opened

List of Tips and Tricks
Just in case you want the tips and tricks shown by the dialog as one single list, here they are.

Context Sensitive Help

If you press the Help Key ( F1 on a PC) then you can get context sensitive help, including within Dialogs.

Keyboard Shortcuts

montage.factory supports numerous keyboard shortcuts as an alternative to using the mouse.

Take a look in the online help or the montage.factory manual for details of the supported keyboard shortcuts

Object Colouring

If an Object such as a Wave or is coloured blue, then it is being referenced by another Object.

If you right click over a blue Object you'll find a "List References" context menu, which will show you the
Objects that reference this one.

Find/Find Next Category Tool Bar Buttons

If you hold the SHIFT key down whilst pressing the Find or Find Next tool bar button the operations
performed change from:

Find to Find Category• 
Find Next to Find Next Category• 

Table Sorting

You can sort Tables by clicking in the Table Column headers.

For example, if you click in the Category Column then the Table will be sorted by Category

You can only DRAG COPY Certain Objects

If you are trying to perform a drag operation on certain data types and are wondering why montage.factory is
not allowing you to perform the drag, try holding down the CTRL key during the drag to see if this is then
allowed. Holding down the CTRL key turns the operation from a Drag Move operation to a Drag Copy
operation.

Sometimes during a drag operation, the only sensible operation that can be undertaken is a copy operation,
for example:
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Copying/Moving Objects to a Different File

When you copy an Object to a different file then any Objects it references can also be copied at the same
time.

For example of you move a Performance to a new File, then the following Objects are also copied (assuming
they are present within the file):

Any User Waves referenced by the Performance• 
Any User Arpeggios referenced by the Performance• 
Any User Motion Sequences referenced by the Performance• 
Any User Curves referenced by the Performance• 
Any Microtunings referenced by the Performance• 

I think you'll agree this is a cool feature!

This feature can be selectively turned off for different Object types if required within the Preferences Dialog.

Workspaces

montage.factory allows you to save a Window arrangement as a Workspace which you can then recall at a
later date.

Moving Objects within a File

When you move an Object within a file then any Objects that reference the Object type being moved can be
updated to ensure they all still reference the correct objects after the move.

For example of you move a within a file then all the Live Set Slots are updated

I think you'll agree this is a cool feature!

This feature can be selectively turned off for different Object types if required within the Preferences Dialog.

Montage File Formats

Whilst montage.factory was written primarily with OS Version 3 files in mind, I have provided legacy OS file
support for the older file versions for OS 1.5 and OS 2.0 as a lot of the publicly available Montage files are
provided in these formats.

montage.factory will preserve the format that a file is in. When you copy data between files of different formats
then it is converted to the later format. You can only copy from older to later file formats
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About montage.factory
The about dialog is shown when the About ... option from the Help Menu or the  button on the Tool Bar is
selected.

The dialog shows some basic information about the program including the version number and the License
status of montage.factory.

It also shows which Java Run Time Environment that montage.factory is running in.
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Glossary
Term Definition
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Keyboard Short Cuts
montage.factory provides many keyboard shortcuts for navigation and performing editing operations.

In general, navigating between components uses these keys:

Tab. Moves keyboard focus to the next component or to the first member of the next group of
components.

• 

Ctrl-Tab. Moves keyboard focus to the next component or to the first member of a group of
components when the current component accepts a tab (as in text fields, tables, and tabbed panes).

• 

Shift-Tab. Moves keyboard focus to the previous component or to the first component in the previous
group of components.

• 

Arrow keys. Move keyboard focus within the individual components of a group of components--for
example, within menu items in a menu or within tabs in a tabbed pane.

• 

The shortcuts are divided into the following categories:

Keyboard shortcuts for the Desktop and Child Wndows• 
Keyboard shortcuts for Tree Views• 
Keyboard shortcuts for Table Views• 
Keyboard shortcuts for Editing within Tree and Table Views• 
Keyboard shortcuts for the Preferences Dialog• 
Keyboard shortcuts for Text Editing Fields• 

Keyboard Shortcuts for the Desktop and Child Windows

Action Keystroke Notes

New File Ctrl-N

Open File Ctrl-O

Save File Ctrl-S

Save File As Ctrl-A

Save All Files Ctrl-L

Open Workspace Ctrl-ALT-O

Save Workspace Ctrl-ALT-S

Tile Horizontally Ctrl-H

Tile Vertically Ctrl-V

Maximise Windows Ctrl-M

Restore Windows Ctrl-R

Minimise Windows Ctrl-I

Closes Child Window Ctrl-F4

Moves Child Window Ctrl-F7

Resizes Child Window Ctrl-F8

Minimizes Child Window Ctrl-F9

Switch to next Child Window on the
Desktop

Ctrl-F6
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Keyboard Shortcuts for Tree Views

Action Keystroke Notes

Expands current Object Right arrow

Collapses current Object, or moves focus
to Parent Object

Left arrow

Moves focus up one Object Up arrow

Moves focus down one Object Down arrow

Moves focus to first Object in Tree View Home

Moves focus to last Object in Tree View End

Moves up one view Page Up

Moves down one view Page Down

Selects all Object in Tree View Ctrl-A, Ctrl-/

Deselects all Object in Tree View Ctrl-\

Extends selection down Shift-down
arrow

Extends selection up Shift-up arrow

Extends selection to beginning of Tree
View

Shift-Home

Extends selection to end of  Tree View Shift-End

Extends selection up one view Shift-PgUp

Extends selection down one view Shift-PgDn
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Keyboard Shortcuts for Table Views

Action Keystroke Notes

Moves up one row Up arrow
Shift-Return

Moves down one row Down arrow
Return 

Scrolls up one view Page Up

Scrolls down one view Page Down

Moves focus and view to first cell in the
current row

Home

Moves focus and view to last cell in the
current row

End

Moves focus and view to first cell in the
current column

Ctrl-Home

Moves focus and view to last cell in the
current column

Ctrl-End

Allows editing in a Category cell F2, Down Arrow

Allows editing in a Name cell. F2

Resets cell to the state it was in before it
was edited

Escape

Selects entire table Ctrl-A

Extends selection up one row Shift-up arrow

Extends selection down one row Shift-down
arrow

Extends selection to beginning of table Ctrl-Shift-Home

Extends selection to end of table Ctrl-Shift-End

Extends selection up one view Shift-PgUp

Extends selection down one view Shift-PgDn
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Keyboard Editing Short Cuts for both Tree and Table Views

Action Keystroke Notes

Undo Ctrl-Z

Redo Ctrl-Y

Cut Ctrl-X

Copy Ctrl-C

Paste Ctrl-V

Find Ctrl-F

Find Next F3

Find Category Ctrl-Shift-F

Find Next Category Shift-F3

Goto Ctrl-G

Insert Object INS Not allowed on
Collections

Delete Object DEL Not allowed on
Collections

Rename Object F4 Single Named Object
Only

Initialise Object F5

List References F6 Single Named Object
Only

Map To Flash F7

Map To Ram Shift-F7

Export to MIDI Edit Buffer F8 Single Voice or
Performance Only

Export to MIDI Memory Shift-F8 Voices or
Performances Only

Import from MIDI Edit Buffer F9 Single Voice or
Performance Only

Import from MIDI Memory Shift-F9 Voices or
Performances Only
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Keyboard Shortcuts for the Preferences Dialog

Action Keystroke Notes

Navigates through tabs Arrow keys

Moves from tab to its associated content
pane

Ctrl-down arrow

Moves from content pane to its
associated tab

Ctrl-up arrow

Keyboard Shortcuts for Text Editing Fields

Action Keystroke Notes

Moves insertion point one character to
the right

Right arrow

Moves insertion point one character to
the left

Left arrow

Moves insertion point to beginning of
next word

Ctrl-right arrow

Moves insertion point to beginning of
previous word

Ctrl-left arrow

Moves insertion point to beginning of
field

Home

Moves insertion point to end of field End

Submits text entry Enter, Return

Extends selection to beginning of line Shift-Home

Extends selection to end of line Shift-End

Extends selection one character to the
left

Shift-left arrow

Extends selection one character to the
right

Shift-right arrow

Extends selection to next word Shift-Ctrl-right
arrow

Extends selection to previous word Shift-Ctrl-left
arrow

 Keyboard Short Cuts 63



Credits
Thanks go, in no particular order, to:

Macke for assistance providing MODX file examples and in beta testing on the MODX.• 
Yamaha for making such a fantastic synthesizer in the Montage/MODX series.• 

3rd party software used in montage.factory
The following 3rd party software is used to build montage.factory and provide some program features.

CoreMIDI4J License

montage.factory makes use of CoreMIDI4J to provide MIDI support on OS X, which is issued under the EPL
1.0 License.

Table Filter License

montage.factory makes use of TableFilter by Luis M. Pena, which is issued under the MIT License.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED,
INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A
PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR
COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN
AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION
WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

Apache Derby License

montage.factory makes use of Apache Derby to provide the library function, which is issued under the Apache
2.0 License.

Apache Log4J License

montage.factory makes use of Apache Log4J to provide logging services, which is issued under the Apache
2.0 License.

Dom4J License

montage.factory makes use of Dom4J to provide XML services, which is issued under the Maplesoft Dom4J
License.

THIS SOFTWARE IS PROVIDED BY METASTUFF, LTD. AND CONTRIBUTORS ``AS IS'' AND ANY
EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL METASTUFF, LTD. OR ITS CONTRIBUTORS BE LIABLE FOR ANY
DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS
OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY
THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN
IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Java Wizard License

The montage.factory Library Batch Importer makes use of the Java Wizard Project which is distributed under
the Open Source Initiative Common Development and Distribution License.

I have adapted the Wizard software to allow me to display two progress bars in the Wizard. If anybody wishes
to have the source code for how I did this, please email me at supportx@xfactory-librarians.co.uk and I will
happily provide the adapted source code.

JSON Simple

montage.factory makes use of JSON Simple to provide logging services, which is issued under the Apache
2.0 License.
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montage.factory License
The unregistered version of montage.factory allows you to evaluate the features of the program, which are
fully functional except the File Save, MIDI Export and Librarian features.

However, montage.factory cannot be included as part of a commercial distribution or on other web sites
without the express permission of the Author. I am happy for you to provide links
to www.xfactory-librarians.co.uk, to maximise public access to montage.factory.

montage.factory license files are issued to users who have registered montage.factory, to gain access to the
File Save, MIDI Export and Librarian features. If you have been issued with a license key you are not allowed
to distribute a license key to other users. Please respect this, and the amount effort I have put into making this
application.

You are permitted to install and activate montage.factory on two computers, for which the license is valid.

If you wish to install and activate montage.factory on more than two computers, then an additional license can
be purchased at 50% of the cost of the main license.

The Author retains the copyright on the program and all of its originally developed features.

Disclaimer
Like all software products, this software is provided "AS IS", and without any warranties expressed or implied.
But hey, remember, you're getting it for a very low cost!

I have worked hard to ensure this software works correctly, as I certainly don't want it trashing my data.
However, I cannot be held liable for any problems arising as a consequence of you using this software on
your computer and your data. You use this product at your risk.

Like all new products, please proceed and evaluate with care, and ensure that all your important data files are
backed up before installation and evaluation.

Having gotten that out of the way, if you do encounter any problems, please submit a bug report
to support@xfactory-librarians.co.uk, and I will endeavour to provide a fix for any reported problems.

Licensing Conditions for 3rd party software
Apache Derby License

montage.factory makes use of Apache Derby to provide the library function, which is issued under the Apache
2.0 License.

Apache Log4J License

montage.factory makes use of Apache Log4J to provide logging services, which is issued under the Apache
2.0 License.

CoreMIDI4J License

montage.factory makes use of CoreMIDI4J to provide MIDI support on OS X, which is issued under the EPL
1.0 License.

Dom4J License

montage.factory makes use of Dom4J to provide XML services, which is issued under the Maplesoft Dom4J
License.

THIS SOFTWARE IS PROVIDED BY METASTUFF, LTD. AND CONTRIBUTORS ``AS IS'' AND ANY
EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL METASTUFF, LTD. OR ITS CONTRIBUTORS BE LIABLE FOR ANY
DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS
OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY
THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN
IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
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Java Wizard License

The montage.factory Library Batch Importer makes use of the Java Wizard Project which is distributed under
the Open Source Initiative Common Development and Distribution License.

Table Filter License

montage.factory makes use of TableFilter by Luis M. Pena, which is issued under the MIT License.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED,
INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A
PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR
COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN
AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION
WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

Tritonus License

montage.factory makes use of Tritonus Java Sound Extensions, which is issued under the GNU Lesser
General Public License.
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